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CAASPP California Assessment of Student Performance and Progress 
CalTAC California Technical Assistance Center 
DBT Duxbury Braille Translator 
ELA English language arts/literacy 
JAWS Job Access with Speech® 
LEA local educational agencies 
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TA Test Administrator 
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Introduction to the Braille Requirements Manual 
This manual provides information about supported hardware and software requirements and how to 
configure Job Access with Speech (JAWS®). General information about administering a test to a 
student with a braille accommodation and printing test material is also included. 

Manual Content 
The following bulleted list contains brief descriptions of each section in this manual. Table 1 includes 
common symbols and elements used throughout the document. 

• Section I. Overview of Braille Testing provides an introduction to testing with braille, including 
a screenshot of the sample interface that students will use. 

• Section II. Technology Requirements outlines the supported operating systems and 
hardware and software requirements for students and Test Administrators (TAs). 

• Section III. Configuring JAWS for Online Testing provides instructions for ensuring that 
JAWS works with the secure browser. 

• Section IV. Configuring Printing Software on TA Computers includes information about 
braille-ready format and printer output file types and how to configure them. 

• Section V. Quick Guide to Online Testing with Braille covers the process for starting a test 
session and printing test content requested by students. Information on how to delete 
temporary downloaded files is also provided. 

• Section VI. JAWS Commands and General Navigation provides an overview of specific 
JAWS commands for use in the online assessments, as well as instructions for navigating 
through the logon screens. 

Table 1.  Key Symbols and Elements 

Element Description 

 
Alert: This symbol accompanies important information regarding a task that may 
cause minor errors.  

 
Note: This symbol accompanies additional information that may be of interest.  

 
Policy: This symbol accompanies information that is based on policy set by the 
California Department of Education. 

[text] Bold text in brackets is used to indicate a link or button that is selectable.  

 
Tip: This symbol accompanies suggestions that may be useful. 

 
Warning: This symbol accompanies important information regarding actions that 
may cause fatal errors. 
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Section I. Overview of Braille Testing 
The online test delivery system (TDS) is available to students who use braille, allowing them to 
access the adaptive algorithm and use the online systems in a similar fashion to general education 
students. 

Students who have a braille accommodation will receive the online assessments in an accessible 
format via the TDS’s Enhanced Accessibility Mode (see Figure 1). The Enhanced Accessibility Mode 
feature is optimized to allow supported screen-reading software and printing of passages and test 
items to braille embossers. 

About Enhanced Accessibility Mode 
When braille is selected as the student’s test language, the test layout will default to Enhanced 
Accessibility Mode. The Enhanced Accessibility Mode layout, shown in Figure 1, is different from the 
standard test interface and is designed to interact with Job Access with Speech (JAWS®) navigation. 
When Enhanced Accessibility Mode is enabled, the test content is laid out vertically. Passages and 
stimuli are located at the top of the screen, with questions appearing below.  

Students who have a braille accommodation but also have some vision may use the Zoom tool 
available in the test to adjust the size of text and graphics as necessary.  

 
Figure 1.  Sample Enhanced Accessibility Mode Layout 
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About Tests and Braille 
The test content determines whether passages and items will be delivered to a braille embosser or to 
a Refreshable Braille Device (RBD) via JAWS.   

English Language Arts/Literacy 
The English language arts/literacy (ELA) tests will present students with items in either contracted or 
uncontracted literary braille: 

• Items that contain only text will be sent to an RBD. 

• Items that contain text and images that cannot be read by an RBD will be sent to a braille 
embosser. 

 

Warning: Because the text-to-speech accommodation is not approved for use with the ELA 
assessments, the sound on the student’s computer will be automatically muted when the 
student begins the first question on a braille ELA test. The sound will automatically turn on 
again when the student submits the braille ELA test or pauses the test and returns to the logon 
screen.  
Some students may require assistance with JAWS navigation during the ELA test because 
they will not be able to hear the JAWS commands when the sound is muted. JAWS will still 
output all commands and text to the refreshable braille display, even with the sound on the 
computer muted. TAs may need to point out the intended lack of sound to the student and 
direct him or her to follow commands in the refreshable braille display. 

Mathematics 
All test content will be delivered in Nemeth braille via a braille embosser. 
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Section II. Technology Requirements 
The technology requirements in this section are specific to online testing with braille. The hardware 
and software that are used for braille testing require the use of a supported Windows operating 
system. 

For information about complete requirements for online testing, refer to the Technical Specifications 
Manual for Online Testing. 

Supported Operating Systems and Related Requirements 
For the 2014–2015 test administration, the following must be installed on computers used for braille 
test administration. 

 Requirements for Student Computers Requirements for TA Computers 
Operating 
Systems* 

Windows 7, 8.0, 8.1 Windows XP (SP 3), Vista, 7, 8.0, 8.1 
Note: Test Administrators (TAs) must use a 
computer running an operating system that 
is supported by Duxbury and ViewPlus 
software. The above systems are 
supported by both the American Institutes 
for Research (AIR) and these third-party 
companies. 

Hardware Refreshable Braille Display (RBD) 
Note: AIR recommends an RBD that has a 
minimum of 40 cells, such as the ALVA 
USB 640 40-cell braille display from Vision 
Cue, LLC. 

ViewPlus Tiger Max Embosser 

Software Windows Secure Brower 7.2 
Job Access with Speech (JAWS®) Screen 
Reader 12, 13, 14, or 15 

Supported Web browser 
Duxbury Braille Translator 11.1 or 11.2 
ViewPlus Desktop Embosser driver  
(for ViewPlus Tiger Max Embosser) 

 

 

Note: For security purposes, tablets running Windows 7 or 8 are not supported for braille 
testing. Only desktop and laptop computers may be used when testing with the braille 
accommodation. 

Software Resources 
This section provides resources for downloading software required for braille testing. 

Software for Students 
• Windows Secure Browser 

Students will use the same Windows secure browser that is used for all online testing. To 
download the Windows secure browser, select the [Secure Browsers] button on the California 
Assessment of Student Performance and Progress (CAASPP) portal (http://caaspp.org). For 
secure browser installation instructions, refer to the Secure Browser Installation Manual on the 
Instructions and Manuals Web page at http://caaspp.org/administration/instructions/. 

• JAWS Screen Reader 
Students can use the same JAWS screen reader with the Windows secure browser as with other 
computer applications. For more information about JAWS, or to download the product, please go 
to http://www.freedomscientific.com/products/fs/jaws-product-page.asp.  

http://caaspp.org/�
http://caaspp.org/administration/instructions/�
http://www.freedomscientific.com/products/fs/jaws-product-page.asp�
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Software for Test Administrators  
• Duxbury Braille Translator (DBT) 

This software allows printing of items and stimuli that do not contain images. The DBT software 
may be downloaded at the following location: http://www.duxburysystems.com/dbt_main.asp.  

• ViewPlus Desktop Embosser Driver 
The driver includes the Tiger Viewer software, which allows printing of items and stimuli that 
contain tactile or spatial components (e.g., images). The driver may be downloaded at the 
following location: http://downloads.viewplus.com/drivers/desktop-braille-embosser/.  

http://www.duxburysystems.com/dbt_main.asp�
http://downloads.viewplus.com/drivers/desktop-braille-embosser/�
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Section III. Configuring JAWS for Online Testing 
Job Access with Speech (JAWS®) must be configured prior to students using it for online testing. This 
section contains instructions for the following: 

• Configuring JAWS to Recognize the Secure Browser 

• Applying Settings for Contracted and Uncontracted Braille 

• Configuring JAWS to Speak “Dollars” 

• Optional JAWS Settings 

Configuring JAWS to Recognize the Secure Browser 
The JAWS versions 12, 13, and 14 require editing the configuration file so that the software will 
recognize the secure browser. This section contains the instructions for modifying the file. 

 

Note: The following instructions are written for JAWS 13 installed to the default location. If you 
have another supported version of JAWS or it is installed to a different location, navigate to the 
appropriate directory. 

 
1. Open the JAWS ConfigNames.ini file. This file may appear in two folders. Depending on 

how JAWS is installed on your computer, both files may need to be modified. Figure 2 
shows a file location. 

• Start > All Programs > JAWS 13.0 > Explore JAWS > Explore Shared Settings 
(required) 

• Start > All Programs > JAWS 13.0 > Explore JAWS > Explore My Settings (optional) 

 
Figure 2.  Find the ConfigNames.ini file 

2. In the ConfigNames.ini file, locate the line of text that contains Chrome=Firefox. At 
the end of this line, press [Enter] on your keyboard to create a new line. In the new line, 
type in the following string:  

CASecureBrowser7.1=Firefox 
Note that the version number must match the version number of the secure browser you 
are using. 

3. Save the file. 
 

 

Note: If you receive an error that you do not have permission to save the .ini file to this 
location, you will first need to save the file to your desktop as ConfigNames.ini. After saving 
the updated .ini file, copy it to the folder containing the original .ini file (referenced in Step 1). 
You will need to confirm that you want to replace the original file with the file you created. 



Section III. Configuring JAWS for Online Testing | Applying Settings for Contracted or Uncontracted Braille 

January 2015 2015 CAASPP Braille Requirements for Online Testing Manual  7 
Customization Copyright © 2014 by the California Department of Education 

Applying Settings for Contracted or Uncontracted Braille 
In order for students to use contracted or uncontracted literary braille with their Refreshable Braille 
Display (RBD), the correct JAWS setting must be applied prior to launching the secure browser. 
Braille mode settings also need to be selected. 

1. Open JAWS, and then select the “Utilities” menu. In the “Utilities” menu, select Settings 
Center. The Settings Center, shown in Figure 3, will open. 

 
Figure 3.  The Settings Center 

2. From the “Application” drop-down list at the top of the Settings Center screen, select 
firefox. 

3. In the “Search for settings” panel on the left side, scroll down to the braille section and 
expand the sub-settings. Select Contracted Braille Translation, shown in Figure 4. 

 
Figure 4.  Selecting Contracted Braille Translation 

4. The Settings Center will display the options for Contracted Braille Translation. 
5. In the Translation section, select the correct option from the Contracted Braille 

Translation type drop-down list, shown in Figure 5.  
• For students who prefer Contracted Braille, select “Input and Output.” 

• For students who prefer Uncontracted Braille, select “Off.”  



Section III. Configuring JAWS for Online Testing | Configuring JAWS to Speak “Dollars” 

8  2015 CAASPP Braille Requirements for Online Testing Manual January 2015 
Customization Copyright © 2014 by the California Department of Education 

 
Figure 5.  Contracted Braille Translation type drop-down list 

6. In the Braille Mode section, ensure that the three settings that follow—and shown in 
Figure 6—are checked (and only these settings are checked): 

• Active cursor follows braille display 

• Enable Braille Auto Detection 

• Enable Word Wrap  

 
Figure 6.  Braille Mode settings 

7. Select [Apply] and then select [OK]. 

Configuring JAWS to Speak “Dollars” 
The instructions in this section will ensure that JAWS correctly speaks the dollar ($) symbol. 

1. Open JAWS, then select the Utilities menu. In the Utilities menu, select Settings Center.   
The Settings Center will open. 

2. In the “Search for settings” panel on the left side, scroll down to the Text Processing 
section and expand the sub-settings. Select Speak Dollars. 
The Settings Center, shown in Figure 7, will display the Number And Date Processing 
options, including Speak Dollars. 
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Figure 7.  Setting Center Number and Date Processing options 

3. Check the box for Speak Dollars. 
4. Select [Apply] and then select [OK]. 

Optional JAWS Voice Adjustment Settings 
JAWS voice settings may be adjusted for individual students based on their needs. The following 
settings must be set prior to administering assessments: Voice Profile, Speaking Rate, and 
Punctuation. Instructions for each setting follow. 

 

Alert: Any optional JAWS settings for a student must be set prior to launching the 
secure browser. Students should take one or more practice tests using JAWS so they can 
determine whether these settings need to be adjusted. 

Opening the JAWS Voice Adjustment Window 
1. Open JAWS and select the Options menu. In the Options menu, select Voices and then 

Voice Adjustment as shown in Figure 8. The “Voice Adjustment” interface will open. 

 
Figure 8.  Opening the “Voice Adjustment” interface 
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Adjusting JAWS Voice Profile, Speaking Rate, and Punctuation Settings 
Voice Profile, Speaking Rate, and Punctuation can be set in the Voice Adjustment interface, shown in 
Figure 9. 

Voice Profile 
1. In the Profile section, select a Voice 

Profile from the Name drop-down list. 
2. Select [Apply].  

Voice Rate 
1. In the Voice section, drag the slider to 

the desired rate of speed. The lower the 
rate, the slower the words will be read 
aloud. 

2. Select [Apply].  

Punctuation 
1. In the Voice section, select the 

Punctuation drop-down list. Select from 
the following options: None, Some, 
Most, and All.  

2. Select [Apply]. 

When all settings are saved, select [OK]. 
 

Figure 9.  Voice Adjustment interface 
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Section IV. Configuring Printing Software on Test 
Administrator Computers 
The test delivery system (TDS) is designed to allow students to print secure test material with Test 
Administrator (TA) approval. This means that the software used for sending print requests to the 
braille embosser must be installed on the computers that TAs will use for test sessions. 

The embossed output for student print requests varies depending on the file type associated with a 
test item. There are two types of files: 

• Braille Ready Format (BRF): The BRF file type handles print requests for items containing 
only text, including formatted tables and poems. This file type is handled by the Duxbury 
Braille Translator (DBT) software. 

• Printer Output File (PRN): The PRN file type handles print requests containing tactile or 
spatial components such as images, diagrams, etc. This file type is handled by the ViewPlus 
Tiger Viewer software. 

Upon approving a print request, the TA must send the file to the embosser using either DBT (for BRF 
files) or ViewPlus (for PRN files) software. The following section provides steps for configuring BRF 
and PRN files using sample files that are available under the “Help” menu on the TA Practice site, 
which is linked on the California Assessment of Student Performance and Progress (CAASPP) Portal 
on the Smarter Balanced Practice and Training Tests Web page at http://caaspp.org/practice-and-
training/index.html.  

Instructions for printing files are located in Section V. Quick Guide to Online Testing with Braille. 

 

Alert: Test Administrators will need to ensure that the Braille Type setting for the student is 
correct prior to approving the student for testing. The Braille Type setting (Nemeth, 
Contracted, or Uncontracted) determines what file type will be used for student print requests. 

Opening Sample BRF and PRN Files on TA Computers 
This section contains instructions for opening sample BRF and PRN files with the correct software 
program and setting default printing preferences. The DBT and ViewPlus Tiger Viewer software must 
already be installed. 

Configuring BRF Files with the DBT Software 
1. Navigate to the CAASPP Portal at 

http://caaspp.org. 
2. Select the [Practice & Training Tests] 

button. 
3. Using your Single Sign-On account, log on 

to the Test Administrator Practice and 
Training Site. 

4. When logged on, select the “Help” menu in 
the top right-hand corner of the screen 
(shown in Figure 10).  

 
Figure 10.  Selecting the "Help" menu 

http://caaspp.org/practice-and-training/index.html�
http://caaspp.org/practice-and-training/index.html�
http://caaspp.org/�
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5. Select [Sample BRF File]. The file dialog 
window, shown in Figure 11, will open. 
a. From the drop-down list next to Open 

with, select Duxbury Braille Translator 
(default) and then select [OK].  
This will open the sample file in the 
DBT program. Continue to Step 9.  

b. If the Duxbury Braille Translator is not 
available as a selectable program, 
follow steps 6–8 below. 

 
Figure 11.  Opening brfsample.brf dialog box 

6. To add Duxbury Braille Translator as the 
default program for opening BRF files: 
a. Select [Browse]. The Choose Helper 

Application window, shown in Figure 
12, will open.  

b. Select the [Browse] button. The 
Choose Helper Application window will 
list the available program files.  

c. Scroll down or navigate to the 
“Duxbury” folder and open it.  

 
Figure 12.  The “Duxbury” folder in the Choose 

Helper Application window 

d. Open the “Duxbury” folder and select 
dbtw.exe, circled in Figure 13. 

e. Select [Open].  
The Duxbury Braille Translator program 
will now appear in the Open with 
program selection window. 

 
Figure 13.  The dbtw.exe file in the Choose 

Helper Application window 
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7. In the Open with program selection 
window (shown in Figure 14): 
a. Make sure the [Duxbury Braille 

Translator] icon is selected. 
b. Check the box for “Always use the 

selected program to open this kind of 
file.”  

8. Select [OK].  
The Duxbury Braille Translator program 
will open and preview the file. 

 
Figure 14.  The [Duxbury Braille Translator] icon in 

the Open with program selection window 

9. In the Duxbury Braille Translator window 
shown in Figure 15, open the Document 
menu and then select [Embosser Setup].  
The Document: Embosser Setup window 
will open. 

 
Figure 15.  The Duxbury Braille Translator window 

10. In the Document: Embosser Setup window 
(shown in Figure 16, the following must be 
selected: 
• Brailler Device: ViewPlus Tiger Max (or 

other ViewPlus embosser) 
• The following Desired Braille Document 

Formatting options must be set: 
– Top margin in lines: 2 
– Binding margin in characters: 5 

11. When you are done, select [OK].  

 
Figure 16.  Document Embosser Setup window 
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12. In the Duxbury Braille Translator window 
(shown in Figure 17), select the File menu 
and then select [Emboss].  
The File: Emboss… window will open. 

 
Figure 17.  Duxbury Braille Translator window 

13. In the File: Emboss… window (shown in 
Figure 18), ensure that only one copy is 
being printed and that the page range is 
set to “All.”  

14. Select [OK].   

 
Figure 18.  File: Emboss... window 

Configuring PRN Files with the Tiger Viewer Software 
1. Navigate to the CAASPP portal at 

http://caaspp.org. 
2. Select the [Practice & Training Tests] 

button. 
3. Using your Single Sign-On account, log on 

to the Test Administrator Practice and 
Training Site. 

4. When logged on, select the “Help” menu in 
the top right-hand corner of the screen 
(shown in Figure 19).  

 
Figure 19.  Selecting the "Help" menu 

http://caaspp.org/�
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5. Select [Sample PRN File]. The file dialog 
window, shown in Figure 20, will open. 
a. From the drop-down list next to Open 

with, select Tiger Viewer and then 
select [OK].  
This will open the sample file in Tiger 
Viewer. Skip to Step 9.  

b. If Tiger Viewer is not available as a 
selectable program, follow steps 6–8 
below. 

 
Figure 20.  Opening prnsample.prn dialog box 

6. To add Tiger Viewer as the default 
program for opening PRN files: 
a. Select [Browse]. The Choose Helper 

Application window will open.  
b. Select the [Browse] button. The 

Choose Helper Application window will 
list the available program files.  

c. Scroll down or navigate to the 
“ViewPlus” folder shown in Figure 21 
and open it.  

 
Figure 21.  The “ViewPlus” folder in the Choose 

Helper Application window 

d. Open the “Tiger” folder, circled in 
Figure 22. 

 
Figure 22.  The "Tiger" folder in the 
Choose Helper Application window 
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e. The Tiger folder may contain several 
“ViewPlus…” embosser folders. Open 
the “ViewPlus Max” folder, circled in 
Figure 23. 

 
Figure 23.  The “ViewPlus Max” folder in the Open 

with program selection window 

f. In the ViewPlus Max folder, select the 
[TigerViewer] icon (circled in Figure 24), 
and then Select [Open].  
The “Tiger Viewer” program will now 
appear in the Open with program 
selection window.  

 
Figure 24.  The [TigerViewer] icon in the Open with 

program selection window 

7. In the Open with program selection 
window (shown in Figure 25): 
a. Make sure Tiger Viewer is selected. 
b. Check the box for Always use the 

selected program to open this kind of 
file.  

8. Select [OK]. The Tiger Viewer program will 
open and preview the file. 

 
Figure 25.  Selecting Tiger View in the Open 

with program selection window 

9. In the Tiger Viewer window shown in 
Figure 26, open the File menu and then 
select [Print].  
The Print current PRN File window will 
open. 

 
Figure 26.  The Tiger Viewer window 
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10. In the Print current PRN file dialog box 
(shown in Figure 27), the following must 
be selected: 
• Printer: ViewPlus Premier or other 

supported ViewPlus embosser 
• Copies: Ensure that only one copy is 

being printed. 
• Printer Model: Ensure the correct model 

is listed (e.g., ViewPlus Pro/Max/Cub). 
11. When you are done, select [Print]. 

 
Figure 27.  Print current PRN file dialog box 
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Section V. Quick Guide to Online Testing with Braille 
This quick guide provides an overview for Test Administrators (TAs) testing students who have a 
braille accommodation. The following sections are included: 

• Creating a Test Session and Approving Print Requests 

• Sending Requested BRF and PRN Files to the Embosser 

• Removing Files from the Web Browser Download Archive 

For detailed information about administering online tests, refer to the California Assessment of 
Student Performance and Progress (CAASPP) Test Administrator User Guide. 

For information about online testing policies, refer to the Online Test Administration Manual. 

 

About Using Braille in Training Tests 
Students who need to take a training test using the braille accommodation must log on to a 
training test session with a Test Administrator. Students cannot print test content directly from 
their computers. Students should use the secure browser for training tests so that their 
experience with testing is more similar to the operational testing environment. 

Creating a Test Session and Approving Print Requests 
This section provides a brief overview of the process for creating a test session, approving students to 
enter the session, verifying students’ test settings, and viewing print requests.  

TA: Review the Student’s Test Settings in the 
Test Operations Management System 
(TOMS) 

1. Open an Internet browser. 
2. Go to http://caaspp.org/ and select the 

[Test Operations Management System 
(TOMS)] button.  

3. Select the [Students] button. 
4. Using the Search for Students Web form 

shown in Figure 28, either enter the 
student’s name or other identifying 
information and then select [Search] to 
find a student.  

Figure 28.  Searching for a student in TOMS 

5. Select the magnifying glass [View] icon for 
the student in the Actions column, shown 
in Figure 29, to access the Student Profile 
screen in Figure 30.  

 
Figure 29.  Student search results 

http://caaspp.org/�
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6. Select the [Test Settings] tab. 
7. Review the student’s test settings 

before approving him or her for testing 
in the Student Profile, shown in 
Figure 29. 
• Language must be set to Braille. 
• Print on Demand must be enabled. 

(Reminder: Your local educational 
agency [LEA] CAASPP Coordinator 
should contact the California Technical 
Assistance Center [CalTAC] by phone 
at least one business day before 
testing to have item printing enabled.) 
Braille Type should be set as follows: 

– Math: Nemeth 
– ELA: Contracted or Uncontracted 

• Emboss Request Type may be set as 
follows: 
– Math and Science: Auto-Request  

(As students move through the 
test, print requests will 
automatically appear on the TA 
Interface.) 

– ELA and Social Sciences: On-
Request  
(Students must manually request 
printing of passages and items as 
they move through the test.) 

8. Log off using the [Logout] button when 
you have finished reviewing test 
settings in TOMS. 

9. Verify that all other test settings are 
correct. 
• If the student’s test language is 

not set to Braille, the student 
should not test. The student’s 
information must be updated in 
TOMS before the student can test.  

After you have verified the student’s test 
settings are correct, you may approve the 
student. Select [Set & Approve]. The student 
will appear in the “Students in Your Test 
Session” table. 

 
Figure 30.  Test Settings in TOMS 
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TA: Log on to TA Interface  
10. Open an Internet browser. 
11. Go to http://caaspp.org/ and select the 

[Test Administrator Interface] button. 
12. Log on with your Single Sign-On 

username and password in the Web form 
that is shown in Figure 31. 

 
Figure 31.  TA Sign In Web form 

TA: Create a Test Session 
13. In the test selection box shown in 

Figure 32, select the test(s) to include in 
the test session. 

14. Select the [Start Session] button. The 
Session ID such as the one in Figure 33 
will be generated automatically.  

 
Figure 32.  Creating a test session 

 
Figure 33.  Sample Session ID 

http://caaspp.org/�
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Student: Log on to a Test Session 
15. Open Job Access with Speech (JAWS®) 

on the student machine. 
16. Open the secure browser on the student 

machine. The student Please Sign In Web 
form, shown in Figure 34, will display. 
• If the student needs to take a practice 

test, select [Go to the Practice Test 
Site].  

17. On the Sign In screen, students must 
enter their first name/confirmation code, 
Statewide Student Identifier (SSID), and 
the Session ID, and then select [Sign In]. 
• If the student is taking a practice test and 

is not entering as a Guest User, the 
Guest User and Guest Session boxes 
must be unchecked prior to entering the 
logon information.  

Reminder: Students taking a practice test 
must enter a training test session created 
by a TA. 

 
Figure 34. Student Please Sign In Web form 

Student: Verify Student Information 
18. On the Is This You? screen (shown in 

Figure 35), the student must verify his or 
her personal information. If the information 
is correct, the student should select [Yes].  

 
Figure 35.  Student verification screen 

Student: Select a Test 
19. On the Your Tests screen (shown in 

Figure 36), the student must select a test. 
The student’s test request will be sent to 
the TA Interface. 

 
Figure 36.  Selecting a student test 
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TA: Approve Student for Testing 
20. On the TA Interface, the student’s name 

and selected test will appear in the 
Approvals preview box, shown in 
Figure 37.  

Select the [Approvals (#)] button. The 
Approvals and Student Test Settings 
screen will display. 

 
Figure 37.  Approving a student test 

21. On the Approvals and Student Test 
Settings screen, select the [See/Edit 
Details] button, shown in Figure 38, for a 
student.  
The student’s test settings will appear on 
the right side of the screen.  

Figure 38.  Approving the student test in the TA Interface 

Student: Verify Test Settings 
22. After you approve the student, he or she 

will see the Is This Your Test? screen 
(shown in Figure 39). The student should 
verify that all test information is correct 
and select [Yes]. 
(If the information is not correct, the 
student should select [No] and 
communicate the incorrect information to 
the Test Administrator.) 

 
Figure 39.  Student verification 

Student: Review Test Instructions and Help 
23. Review the information on the Test 

Instructions and Help screen, shown in 
Figure 40.  

24. To proceed and start the test, select 
[Begin Test Now]. 

 
Figure 40.  Test Instructions and Help screen 
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Student: Submit Print Requests 
25. For tests that require manual print 

requests, students must open the context 
menu for a passage or item and select the 
print option. The request will be sent to 
the TA. The [Context Menu] icon is circled 
in the sample item in Figure 41. 
• For passages, the student must select 

the print option in the passage menu. To 
open the menu, select the [Context 
Menu] icon [ ] at the top right of the 
passage. The menu will include a print 
option. Select [Print]. 

• For items, the student must select the 
printer option in the item’s menu. To 
open the menu, select the [Context 
Menu] icon [ ] at the top right of the 
item. The menu will include a print 
option. Select [Print].  

Reminder: For tests that have auto-emboss 
request enabled, the print requests will 
automatically appear on the TA Interface as 
the student moves through the test. 

 
Figure 41.  Submitting a print request 

TA: Approve Print Requests 
The Students in Your Test Session table, 
sampled in Figure 42, includes a Requests 
column. When a student submits a print request, 
the Requests column header changes color and 
a [Print] button appears for the student who 
submitted the request. 

26. Select the [Print] button for the student 
who submitted the print request. The 
Student Print Request(s) window, like the 
one in Figure 43, will open. 

27. Review the print requests. Multiple 
requests may appear. 

28. Select [Approve] for each print request 
that is allowed. Select [Deny] for incorrect 
(or duplicate) print requests.  

29. Process the print requests. (For 
information, refer to the next section.) 

 
Figure 42.  Students in Your Test Session table 

 
Figure 43.  Student print requests 
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Policy: Deleting Files and Discarding Test Material 
• When the student’s test session is completed, all test materials must be deleted and 

discarded.  
• For instructions on deleting downloaded files, refer to the Removing Files from the Web 

Browser Download Archive section. 
• Printed test materials must be securely destroyed. 

Sending Requested Braille-ready Format (BRF) and Printer Output Files 
(PRNs) to the Embosser 
The instructions in this section assume the TA has begun a test session and approved a print request 
from a student.  

Printing BRF Files 
Upon approving a print request for a test 
passage or item that will be printed in BRF 
format, a print dialog box like the one shown in 
Figure 44 will open. 

1. Select Open with (not Save File). 
2. In the drop-down list, make sure “Duxbury 

Braille Translator” is selected.  
3. Select [OK]. The Import File dialog box will 

open. 

 
Figure 44.  BRF printing dialog box 

4. On the Import File dialog box, ensure that 
the following are selected: 
– Template: “English (American) – 

Standard Literary Format” 
– Import Filter: “Formatted braille” 

5. Select [OK].  
The Duxbury Braille Translator preview 
window will open. 

 
Figure 45.  Import File dialog box 
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6. In the Duxbury Braille Translator preview 
window, shown in Figure 46, open the File 
menu and select [Emboss…].  
The File: Emboss… dialog box will open. 

 
Figure 46.  Duxbury Braille Translator 

preview window 

7. In the File: Emboss… dialog box, shown in 
Figure 47, ensure the following are 
selected: 
– Copies: 1  
– Page range: All 
– Brailler Device: Viewplus Premier 

8. When you are ready, select [OK]. The 
print request will be sent to the Tiger Max 
embosser.  

 
Figure 47.  File: Emboss… dialog box 

Printing PRN Files 
1. Upon approving a print request for a test 

passage or item that will be printed in PRN 
format, a print dialog box like the one 
shown in Figure 48 will open. 
– Select Open with (not Save File). 
– In the drop-down list, make sure “Tiger 

Viewer” is selected. 
– Select [OK]. The Tiger Viewer preview 

window will open. 

 
Figure 48.  PRN printing dialog box 
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2. In the Tiger Viewer preview window, 
shown in Figure 49, open the File menu 
and then select [Print].  
The Print current PRN File dialog box will 
open. 

 
Figure 49.  Tiger Viewer preview window 

3. In the Print current PRN File dialog box, 
shown in Figure 50, the following must be 
selected: 
– Printer: ViewPlus Premier or other 

supported ViewPlus embosser 
– Copies: Ensure that only one copy is 

being printed. 
– Printer Model: Ensure the correct model 

is listed (e.g., ViewPlus Pro/Max/Cub). 
4. When you are ready, select [Print]. The 

print request will be sent to the Tiger Max 
embosser. 

 
Figure 50.  Print current PRN File dialog box 

Removing Files from the Web Browser Download Archive 
Most supported Web browsers automatically save downloaded files. If your computer automatically 
saves the BRF and PRN files, you will need to ensure that no one else can print the requested test 
materials. For security purposes, all test-related files must be deleted from your Web browser’s 
download archive.  

Google Chrome 
1. Open Google Chrome. 

2. Open the [Chrome Menu] icon [ ] in the upper right corner. 

3. Select [Downloads]. The Downloads tab will open. 

4. Remove all test-related files.  

Option 1: For each file, select the [Remove from list] link. 

Option 2: Select the [Clear all] link in the upper right corner. (This will not delete any files you 
may have saved to your computer.)  

Internet Explorer 
1. Open Internet Explorer. 

2. Select the [Settings] gear icon [ ] in the upper right corner. 

3. Select View Downloads. The View Downloads window will open. 

4. Delete all test-related files. 
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Option 1: Select each file and press the [Delete] key on your keyboard. 

Option 2: Select the file name with your right mouse button and select “Delete File” from the 
pop-up menu. 

Option 3: Select the [Clear list] button located at the bottom of the View Downloads window. 
This will remove all temporary downloaded files, including any other files you may have 
downloaded. (This will not delete any files you may have saved to your computer.) 

 
Note: Depending on your download settings (where temporary files are saved), you may also 
need to delete files from your Temporary Internet Files folder. 

Mozilla Firefox 
1. Open Firefox. 

2. Open the Tools menu and select [Downloads] or select the [Downloads] icon [ ]. The Library 
window will open. 

3. Delete all test-related files. 

Option 1: Select each file and press the [Delete] key on your keyboard. 

Option 2: Select the [Clear Downloads] link located at the top of the Library window. This will 
remove all temporary downloaded files, including any other files you may have downloaded. 
(This will not delete any files you may have saved to your computer.) 
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Section VI. Navigating the Test with JAWS 
This section provides an overview of how students can navigate through the test using Job Access 
with Speech (JAWS®) commands. Included in this section are the following: 

• Navigating Through the Sign In Screens 

• Navigating Within the Test 

• Responding to Items 

As Test Administrators (TAs) work with students to familiarize them with using the test delivery system 
(TDS), they should make students aware that the braille transcriptions may not follow the usual braille 
rules. TAs and students should review the information in this section prior to taking a Practice or 
Training Test or operational assessment. 

 
Tip: As the student interface has recently been updated, students are encouraged to take 
multiple practice tests to ensure familiarity with JAWS navigation during testing. 

Navigating Through the Sign In Screens 
This section provides instructions which allow students to move through the various logon screens 
until they access the first page of the test.  

Please Sign In Screen (Figure 51) 
To navigate between the fields, press the [Tab] 
key on the keyboard. There are five text boxes 
and a [Sign In] button.  

1. Press [Tab] to navigate to the First Name 
field. Enter your first name. 

2. Press [Tab] to navigate to the SSID field. 
Enter your SSID.  

3. Press [Tab] to navigate to the first text box 
for the Session ID. Enter the first portion of 
the hyphenated text given to you by your 
TA. 

4. Press [Tab] to navigate to the second text 
box for the Session ID. Enter the next set of 
hyphenated text given to you by your TA. 

5. Press [Tab] to navigate to the third text box 
for the session ID. Enter the remaining text 
given to you by your TA. 

6. Press [Tab] to navigate to the [Sign In] 
button. Press the [Enter] key to log on. 

 
Figure 51.  Please Sign In screen 

Note: Beginning this year, Session IDs will 
have three parts. As a result, the Session 
ID field is now split into three text boxes. 
The hyphens are automatically provided.  
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Is This You? Screen (Figure 52) 
This screen requires you to verify your personal 
information. 

1. To listen to each line of text, press the 
[Down] arrow. The listed demographic 
information will be read aloud.  

2. To move to the [No] and [Yes] buttons, 
press [Tab]. 

3. To select the [No] or [Yes] button, press 
[Enter]. 

 
Figure 52.  Is This You? screen 

Your Tests Screen (Figure 53) 
This screen lists the available tests for your grade 
level. Tests are listed in a two-column table. You 
will first hear the test name, then the opportunity 
number, and then the link to choose that test. 

1. To move to the first test listed on this 
screen, press [Tab]. 

2. To navigate between the test names, press 
the [Tab] key. The order of navigation is 
from left to right and top to bottom, in a 
zigzag pattern. 

3. To start or resume a test, press the [Enter] 
key.  

 
Figure 53.  Your Tests screen 

Is This Your Test? Screen (Figure 54) 
This screen lists your test information. You need 
to verify that all test information and settings are 
correct. 

1. To listen to each line of text, press the 
[Down] arrow.  

2. To move to the [No] and [Yes, Start My 
Test] buttons, press [Tab]. (You can also 
press the [B] key.) 

3. To select the [No] or [Yes, Start My Test] 
button, press [Enter]. 

 
Figure 54.  Is This Your Test? screen 
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Test Instructions and Help Screen (Figure 55) 
This screen provides a basic overview of test 
rules and available tools.  

1. To listen to each line of text, press the 
[Down] arrow.  

2. To move to the [Return to Login] and 
[Begin Test Now] buttons, press [Tab] until 
you reach the button you want. (You can 
also press the [B] key.) 

3. To select the [Return to Login] or [Begin 
Test Now] button, press [Enter]. 

 
Figure 55.  Test Instructions and Help screen 

Navigating Within the Test 
This section provides instructions that describe how students can move around on a test page, which 
is sampled in Figure 56. 

 
Note: The first time the test loads, JAWS may start reading everything until the student stops 
it. However, on the next test page, JAWS will focus on the first item on the page.  

 

 
Figure 56.  Example test page 

About Test Elements 
A test page has up to three primary landmark elements: the Banner (test and student information) 
region, Navigation and test tools region, and the test content region. To navigate between these 
landmarks using JAWS, press the [R] key. 
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1. Banner: The banner contains two rows. 
• Test Information Row: This row displays the current question number(s), test name, student 

name, test settings button, and help button. 
• Navigation and Test Tools Row: This row displays the navigation and tool buttons. 

2. Stimulus/Passage: The Stimulus section contains the following elements: 
• Stimulus/passage title 
• Stimulus/passage context menu 
• Stimulus/passage content 

3. Item: Each item contains the following elements: 
• Item number 
• Item context menu 
• Item stem 
• Response area/answer options 

JAWS Keyboard Commands 
Students can use the keyboard commands in Table 2 to navigate within a test page. Please note that 
this is a subset of all available JAWS commands. 

 

About JAWS Keyboard Commands 
The commands in this table are based on JAWS 15. Commands may be slightly different in 
earlier versions. 

Table 2.  JAWS keyboard commands 

Action Keyboard Command 

Navigate to the next landmark element on the page. 
• In general, the following elements are landmarks: 

– Banner at top of screen (contains test information) 
– Navigation and test tools row 
– Content section (contains passages and items) 

[R] 

Move to the next line on the page. [DOWN] Arrow 

Move to the previous line on the page. [UP] Arrow 

Move to the next component on the page. 
• In general, the following test elements are components: 

– Item number (and associated item stem text) 
– Item context menu 
– Response options 
– Navigation and tool buttons 

[TAB] 

Move to the previous component on the page. [SHIFT + [TAB] 
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Action Keyboard Command 

Jump to the next heading on the page.  
• In general, the following test components are defined with a heading: 

– Test name (H1) 
– Student name (H2) 
– Passage title (H3) 
– Item number (H3) (not the actual question text) 

Note: On test pages that have multiple items, students can jump directly 
from one item to the next. To do so, press [H] and then press the [Down] 
arrow TWICE. The item stem will then be read aloud.  

[H] 

Jump to the previous header on the page. [SHIFT] + [H] 

Select an option or button. [ENTER] 

Read everything on the page (from your current place on the page). [INSERT] + [DOWN] Arrow 

Stop JAWS from reading. [CTRL] or [Space bar] 

Opening a Context Menu 
The first item on a test page will automatically be “in focus.” The instructions in this section assume 
the student wants to open the context menu for the active (in focus) landmark element on the page 
and has not yet used the [Tab] key to navigate anywhere. 

To open the context menu for a stimulus or passage: 

1. Ensure the focus is on the stimulus or 
passage. 

2. To navigate directly to the context menu 
button, press [Tab] twice. JAWS will read 
aloud “Menu has pop-up link.” 

3. Press the [Enter] key. The context menu 
will open and display the list of available 
menu options, as shown in Figure 57. 
JAWS will read aloud the first item in the 
menu (for example, “Print Passage”). 

4. To move up and down the list, press the 
[Up] and [Down] arrow keys. JAWS will 
automatically read aloud each item. 

5. To select a menu option, press [Enter]. 
To exit the menu without making a selection, 
press the [Esc] key. JAWS will return focus to 
the context menu button. 

 
Figure 57.  Opening a context menu for 

a stimulus or passage 
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To open the context menu for an item: 

1. To navigate directly to the context menu 
button, press [Tab] twice. JAWS will read 
aloud “Menu for (item number) has pop-up 
link.” 

2. Press the [Enter] key. The context menu 
will open and display the list of available 
menu options, as shown in Figure 58. 
JAWS will read aloud the first item in the 
menu (for example, “Mark for Review”). 

3. To move up and down the list, press the 
[Up] and [Down] arrow keys. JAWS will 
automatically read aloud each item. 

4. To select a menu option, press [Enter]. 
To exit the menu without making a selection, 
press the [Esc] key. JAWS will return focus to 
the context menu button. 

 
Figure 58.  Opening a context menu for an item 

Responding to Items 
This section provides basic guidance for responding to item types that may appear on Practice or 
Training Tests and operational assessments. 

 
Alert: Students should review questions via a Refreshable Braille Display (RBD) or 
printout from a braille embosser before responding to items.  

Multiple-Choice 
Multiple-choice items require you to select one answer option. The response area will display several 
multiple-choice options as radio buttons. You must select a radio button. 

1. After listening to the question text, press 
the [Tab] key twice. 
JAWS will read aloud the option letter and 
option text; these are shown in Figure 59. 
(For example, “Option A, Response 1”). If 
the option is an image, JAWS will read the 
text description associated with the image. 

2. To navigate between each answer option, 
use the [Tab] and [Shift] + [Tab] 
commands. (You can also use the [Up] 
and [Down] arrow keys to move between 
options.) 
JAWS will read aloud the corresponding 
option letter and option text. 

3. To select an answer option in focus as 
your response, press the [Enter] key. The 
radio button will be selected, and JAWS 
will read “Enter” aloud. 

 
Figure 59.  Selecting a radio button 
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Multi-Select 
Multi-select items require you to select more than one answer option. The response area will display 
several answer options as checkboxes. You must select at least one checkbox. 

1. After listening to the question text, press 
the [Tab] key twice. This will take you to 
the first answer option.  
JAWS will read aloud the option letter and 
option text that is in focus. (For example, 
“Response 1.”) If the option is an image, 
JAWS will read the text description 
associated with the image. 

2. To navigate between each answer option, 
use the [Tab] and [Shift] + [Tab] 
commands.  
JAWS will read aloud the corresponding 
option letter and option text. 

3. To select an answer option in focus as 
your response, press the [Space bar] key; 
a sample question with options selected is 
shown in Figure 59. A check mark will 
appear for that answer option and JAWS 
will read “Space” aloud. 

 
Figure 60.  Responding to a multi-select item 

Hot Text  
Hot text items require you to select at least one word, phrase, or sentence. For these item types, it is 
critical to follow the instructions provided in the item. Some items may tell you to select two 
responses. Others may tell you to select one response.  

 
Note: Each selectable text area is pre-defined. If you select a phrase or sentence, all the 
words in that text area will automatically be marked as selected. 

 
1. After listening to the question text, press 

the [Tab] key twice. This will take you to 
the first selectable word, phrase, or 
sentence.  
JAWS will read aloud the text that is in 
focus (“Selectable sentence 1” in 
Figure 61). 

2. To navigate between each selectable text 
area, use the [Tab] and [Shift] + [Tab] 
commands.  
JAWS will read aloud the selectable text. 

3. To choose a selectable text area in focus 
as your response, press the [Enter] key. 
JAWS will announce the text is checked. 

 
Figure 61.  Selecting hot text 
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Edit Text 
Edit text items require you to replace an incorrect selectable word or phrase. For these item types, it is 
critical to follow the instructions provided in the item. Note the following: 

• Some edit text items require you to enter the response into a text box, such as that shown in 
Figure 62.  

• Some edit text items require you to select a response from a drop-down list, such as that 
shown in Figure 63. 

 
Figure 62.  Edit text: text box entry 

 
Figure 63.  Edit text: drop-down options 

 

 

Important Notes about JAWS and Edit Text Items 
• Each selectable text area is pre-defined. For selectable text, JAWS will indicate whether the 

word or phrase is “clickable” and then continue reading the rest of the sentence or line. 
• Some edit text items require students to make changes that are punctuation-based (e.g., 

students may be asked to replace a comma with a different punctuation mark). For these 
edit text items, JAWS will need to read in character mode. 

 

 
Tip: It is strongly recommended that students read through an entire item before editing text. 
Students can listen to the item as well as read it via a RBD or printout from an embosser.  

 
1. Use the [Down] arrow to read through each line of text.  

If a line of text has a selectable word or phrase, JAWS will say “clickable” after the word 
or phrase.  

2. Navigate to each selectable text field in the item.  
Option 1: Return to the beginning of the item. 

a. Press [Shift] + [H]. 
b. Press [Tab] to go to the first selectable text field.  

Option 2: Move backwards through the selectable text fields in the item. 
c. Press [Shift] + [Tab]. 

3. When the selectable text is in focus, press the [Space bar]. This will open the edit menu. 
JAWS will read “Edit tools dialog” aloud and provide additional instructions.  
• Text box: Type in the replacement word or phrase.  
• Drop-down list: Use the [Up] and [Down] arrow keys to move between options in the 

list. JAWS will read each option aloud. To select an option, press [Enter].  
4. Press [Tab] to navigate to the [OK] button in the edit menu. Press [Enter]. The edit menu 

will close and the item will be back in focus. 
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Open Response 
Open-response items, like the sample item in Figure 64, require you to enter text into a text box. You 
may be asked to write a sentence or paragraph.  

1. Read the question and then use the [Tab] 
command to move to the response area 
(text box). JAWS will read “Edit, type in 
text” aloud. 

2. When you are done entering a response, 
press [Tab].  
You will leave the text box and move to 
the next item on the page. 

 
Figure 64.  Answering an open-response item 

Open Response with Text Formatting Row 
Open-response items require you to enter text into a text box. You may be asked to write a sentence, 
paragraph, or essay. These items include a row for formatting text, which is circled in Figure 65. 
Formatting options include bold, underline, italics, numbered bulleting, symbol bulleting, and more.  

1. Read the question and then use the [Tab] 
command to move to the response. JAWS 
will read “Edit, type in text” aloud. 

2. Enter your response into the text box. 
3. When you are done entering a response, 

press [Tab] to exit the response area.  
You will leave the text box and move to 
the next item or field on the page. 

 
Figure 65.  Answering an open-response item with text 

formatting 

Resource: http://docs.cksource.com/CKEditor_3.x/Accessibility 

Table Match 
Table-match items, like the sample item in Figure 66, require you to mark at least one check box in a 
table. The table will have multiple rows and columns. The table row heading and column heading are 
not selectable. The selectable table cells have check boxes. 

http://docs.cksource.com/CKEditor_3.x/Accessibility�
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1. After listening to the question text, press the 
[Tab] key twice. This will take you to the first 
table cell that has a check box.  
JAWS will read aloud the corresponding 
column name and row name for that table cell. 

2. To navigate to each cell that has a check box, 
press the [Tab] key.  
JAWS will read aloud the corresponding 
column and row name for each cell. 

3. To mark a check box, press the [Space bar]. 

 
Figure 66.  Responding to a table-match item 

 


	Introduction to the Braille Requirements Manual
	Manual Content

	Section I. Overview of Braille Testing
	About Enhanced Accessibility Mode
	About Tests and Braille
	English Language Arts/Literacy
	Mathematics


	Section II. Technology Requirements
	Supported Operating Systems and Related Requirements
	Software Resources
	Software for Students
	Software for Test Administrators 


	Section III. Configuring JAWS for Online Testing
	Configuring JAWS to Recognize the Secure Browser
	Applying Settings for Contracted or Uncontracted Braille
	Configuring JAWS to Speak “Dollars”
	Optional JAWS Voice Adjustment Settings
	Opening the JAWS Voice Adjustment Window
	Adjusting JAWS Voice Profile, Speaking Rate, and Punctuation Settings


	Section IV. Configuring Printing Software on Test Administrator Computers
	Opening Sample BRF and PRN Files on TA Computers
	Configuring BRF Files with the DBT Software
	Configuring PRN Files with the Tiger Viewer Software


	Section V. Quick Guide to Online Testing with Braille
	Creating a Test Session and Approving Print Requests
	Sending Requested Braille-ready Format (BRF) and Printer Output Files (PRNs) to the Embosser
	Printing BRF Files
	Printing PRN Files

	Removing Files from the Web Browser Download Archive
	Google Chrome
	Internet Explorer
	Mozilla Firefox


	Section VI. Navigating the Test with JAWS
	Navigating Through the Sign In Screens
	Navigating Within the Test
	About Test Elements
	JAWS Keyboard Commands
	Opening a Context Menu

	Responding to Items
	Multiple-Choice
	Multi-Select
	Hot Text 
	Edit Text
	Open Response
	Open Response with Text Formatting Row
	Table Match





